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ELECTRONIC ARTS PRODUCTS FOR APPLE IIGS 

DELUXEPAINT Il 
The most powerful microcomputer paint program ever made comes to the Apple IIGS! All the tools you ever wanted in 
a paint program are at your fingertips. Pick up any piece of art and use it as a brush. Paint with multiple colors on your 

brush or merge two pieces of art. Rotate the brush to any angle, flip it horizontally or vertically, stretch it or shear it 
into a new shape. Choose your 16 color palette from the 4096 colors possible. Automatically generate shades of color 

in a range. Fill any bounded space with any pattern from a brush or with a range of colors gradually blending. Lock out 
screen areas so you can paint "behind" or "in front” of other art. Turn 2D into 3D with one click — take a brush and 
rotate it around all three x, y, and z axes to create perspective. Paint on a grid for precise spacing, or use coordinates 

for exact point-to-point measurement. And there's even more features! 

DELUXEPRINT . 
Express yourself in ways you never could before using the full graphics power of the Apple IIGS. Take artwork you've 
created with DeluxePaint II and use it in DeluxePrint. Among other things DeluxePrint will make with fabulous full color 

artwork: 

Greeting Cards « Signs * Calendars » Posters * Stationery * Labels « Stickers « T-Shirt lron-ons » Letterheads « Flyers » 
Banners « Invitations » Handouts » Name Tags * Bookmarks * Menus « Wrapping Paper » Message Pads 

DELUXE MUSIC CONSTRUCTION SET 
The ultimate music tool for performing, composing, or publishing. The perfect answer for Music Construction Set 
users who want more musical power. Play digitized instruments in a dynamic range from ppp to fff, with playback 

speed from 1 to 240 beats/minute. See the music scroll by as it plays. Use MIDI out to control MIDI instruments. Full 
Cut, Paste, and Copy music editing, with keyboard options for the entire note palette. Multiple time and key 
signatures in a piece. Dozens of musical symbols onscreen and in printout for full music notation power. Parts printing 

onscreen or in printout. Professional power and ease of use. 

INSTANT MUSIC 
Create great-sounding music instantly, with no mistakes. Always in the right rhythm and key, with real digitized 
instrument sounds and human voices. Write great-sounding music instantly, and then jam to your composition and 

never miss a note. Instant Music's artificial intelligence will make you sound terrific! 

HOW DO | GET THESE OTHER GREAT PRODUCTS? 
If you want to be the first to know when these products are coming out, be sure to fill out your registration card and 
send it in! You'll receive absolutely free our quarterly newsletter, beginning early 1987, that will give you the latest 

information on the products and their availability. 
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PLAYING WITH MUSIC 

Welcome to a whole new way to explore and play in the world of music. Music Construction Set 
turns the building blocks of music (notes, rests, sharps, flats, and so on) into pictures that you can 

actually grasp and assemble on your computer screen — and ask your computer to play back to you. 

You can control the speed, volume and sound quality of the playback, experiment with quick 

changes in the placement of notes, cut measures out and paste them back in someplace else (even into 

a completely different song!), change keys, print out your composition on paper...the possibilities 

are virtually limitless. Best of all, the program is as easy to use as pointing and clicking. 

The manual you're holding is your passport to this new world of computer-made music. Chapter 1 

gives you the steps you need to start having fun with Music Construction Set right now, using 

music already on your disk. Chapter 2 gives you an in-depth tour of the program's powerful 

features and shows you how you can use MCS to create new sounds of your own — even if the only 

thing you know about music right now is what you like to hear. Chapter 3 lets you put your new 

knowledge to work with a series of musical games designed to show you what you and MCS can do 

together. Finally, there's a glossary that defines the musical terms used throughout the manual. 

The Command Summary card packaged with the program contains a list of the music and 

instruments that come ready to play on your MCS disk. You'll also find instructions for loading the 

program and using Music Construction Set's MIDI interface, which lets you use electronic 

instruments with your computer. Take a few moments to get familiar with the card: the manual 

often refers to musical examples, and knowing the basics of MCS operation allows you to listen to 

the examples as well as read about them. : 

One final note. Don't let this guide be your only resource — there's a world full of music out there 

for you to enter, to push and poke at to see what makes it tick. Music books labeled "easy piano" are 

good places to start. As you explore, remember this: though computer music is a new idea, music 

itself has been around for a long time. Don't be shy about using the musical artists and craftsmen 

who have gone before you as a source of inspiration, ideas and guidance as you set out on your own 

journey to greater musical understanding and enjoyment. 



CHAPTER 1: QUICK START 

1. Load the program according the instructions on the enclosed Command Summary Card. When 

MCS is fully loaded, the program screen appears, and your computer automatically starts 
playing a song. Press any key to stop the demo and clear the score. At this point, you have two 

options: you can call up one of the songs already stored on the disk, or you can start writing music 

of your own. 

2. To load an existing song, use the mouse to move the pointer to the File heading on the menu 

bar at the top of the screen, and hold down the mouse button. Drag the pointer down until Open 

is highlighted, and release the mouse button. 

After a moment, a dialog box appears, offering you a list of the songs currently on the MCS disk. 

Move the pointer to highlight the song you'd like to work with, and click. Then move the 

pointer to the Open button, and click again (or you can just double-click on the highlighted 

song). In just a few seconds, the dialog box disappears, and your song opens on the screen. To start 

the music, move the pointer to the Play menu, and select Play. To stop it before the end, click 

the mouse button or press any key. 

3. To start writing your own music, use the mouse to move the pointer to the File heading, 

hold down the mouse button, drag the pointer down until New is highlighted, and release the 
mouse button. Click OK, and the screen clears, giving you a fresh score to work on. 

Use the pointer to select notes, rests, and other items from the Parts Box at the bottom of the 

screen. Click on the item you want to pick up, and it attaches itself to the pointer. Move the 

pointer up to position the item in the score, and click again to drop it from your pointer. (If you 

hold the command key down while selecting the note, it attaches permanently to the pointer, 

allowing you to "stamp" notes down as many times as you want. To drop the note, move the 

pointer to an empty spot in the Parts Box and click, or press Delete.) The twin sliders at the 

right of the Parts Box control the volume of your composition (one for the treble staff, one for the 

bass staff); the third one controls the tempo. 

Now that you know how easy and straightforward Music Construction Set is to use, you might 

want to get acquainted with the program's many useful features. They're covered in Chapter 2, 

which starts on the next page... 



CHAPTER 2: MAKING MUSIC WITH MCS" 

In the previous chapter, you saw how to get Music Construction Set up and running, and learned 
to use the pointer. Now, let's take a close look at the many powerful tools in MCS. The first part of 
this chapter covers the features on the program screen; the second part shows you what you can do 
with the pull-down menus at the top of the screen. Along the way, you'll also learn a few things 
about how music works. All the words that appear in italics are included in the glossary at the 
back of the manual. Keyboard commands are also noted on the Command Summary card packaged 
with this program. 

THE PROGRAM SCREEN 

The program screen consists of three parts: the Menu Bar, the Score Screen, and the Parts Box: 

The Menu Bar 

The Menu Bar stretches across the top of the screen, and contains four headings: xB , File, Edit, and 

Play. We'll look at these headings, and the menus under them, in the second section of this 

chapter. 

The Score Screen 
This is Music Construction Set's center stage, the place where you make the music happen. The 
basic elements of the score screen are: : 

The Two Staffs — Music is written on groups of lines and spaces called staffs. These are the two 
sets of five lines that run across the screen. At the beginning of each staff is a clef symbol — either 
treble clef, which looks like a sort of like a backwards S, or bass clef, which looks like a backwards 
C. Higher notes go on the treble clef, and lower notes on the bass clef. Although musicians 
sometimes find it useful to make both staffs one clef (if the music is very high or very low), in MCS 
the top staff is always treble, and the bottom staff is always bass. 

Each line and space on the staff represents a tone on the scale, and is given a letter name, from A 
through G. In treble clef, the bottom line of the staff is E, the space above it is F, the next line up is 

G, then A, and so on in alphabetical order. In bass clef, the bottom line of the staff is G, the next 

space up is A, and it goes up alphabetically from there: 



Musicians rely on these phrases to help them keep track of the lines and spaces for each staff: 

Treble: Every Good Boy Does Fine (lines) 
FACE (spaces) 

Bass: | Good Boys Do Fine Always (lines) 
All Cows Eat Grass (spaces) 

Pick up a note with the pointer, and move note over the two staffs while holding down the 
Command key. The letter name of the line or space the note currently occupies appears in the 
lower right part of the Parts Box, next to the three sliders. 

Lines and spaces with the same letter names produce sounds that blend together perfectly, and the 
distance between them — the eight-note scale — is called an octave. 

Because a piano keyboard has many more keys than there are lines and spaces on the two staffs, 
the areas above, below, and between the staffs can be used to continue a scale beyond the staff. The 

first line below the treble staff is the same note as the first line above the bass staff. It's called 
middle C, since it's located in the middle of the piano keyboard. Notes higher than middle C go on 
the treble staff; lower notes go on the bass staff. 

Measure Bars — The two staffs are connected every few inches by vertical measure bars. All 
music is played to a series of even beats, which are counted off: one, two, three, four, one, two.... A 

complete sequence of beats is called a measure. The number of beats in a measure varies: waltzes 
have three beats per measure, marches often have only two, and it's not uncommon to find songs that 
have six. 



The Time Signature — To the right of the clef on each staff is the time signature. It looks just 
like a mathematical fraction. MCS lets you choose from seven time signatures: 4/4 (also known as 
common time: it can also be denoted with the letter C in place of a regular time signature), 3/4, 2/4, 

3/8, 6/8, 3/2, and cut (2/2) time, which is written like a cent sign and works like very fast 4/4 time. 

The bottom number in each time signature indicates what kind of note or rest is counted as one beat 
while the music is playing, and the top number tells you how many beats there are in each measure. 
For example, in 2/4 time, there are two beats between each measure bar, and a quarter note receives 

one beat; in 6/8 time, there are six beats per measure, and every eighth note gets one beat. | 

To change the time signature, put the pointer on the existing time signature and click. The signature 
changes every time you click — just stop clicking when MCS gives you the time signature you want 
for your piece. 

Accidentals and Key Signatures — In music notation, what you see is not what you get in one 
very important respect: the lines and spaces are evenly laid out, even though the sounds they 
represent are not. The journey from one C to the next has more than just the alphabetical steps in it. 
There are half-steps as well, which is where sharps, flats, and naturals come in. Sharps raise 
sounds one half-step, and flats lower them a half-step. Naturals cancel out both sharps and flats. 
Collectively, these symbols are called accidentals. 

As an example of how accidentals work, let's say that you have a measure with four quarter notes 
on line B. To make B into B flat, place a flat symbol right next to the first B in the measure. The 
flat symbol remains in effect, changing all the B notes that follow, until the measure ends. But 
wait — you only wanted to make the first B flat, and leave the rest as they were! That's easy: just 
put a natural sign in front of the second B note, and the rest of Bs in that measure will also change 
back. (The same principles apply to sharps.) 

_ To change the key signature for the entire piece, click in the empty space just to the left of the time 
signature in the treble clef. With the first click, you'll see a sharp appear on the top F line. This 
means that every F in the piece will be played as F#. Another click adds a second sharp...and a 
third...up to seven. On the eighth click, the sharps disappear, and one flat appears on the B line. 
You can add up to seven flats with more clicks. To find out more about how key signatures work, see 
the tutorials in the next chapter. 



Scroll Bar — At the very bottom of the Score Screen is the Scroll Bar, which you use to move back 

and forth in your piece. It's a long pink bar, with a small white rectangular cursor that shows 

where you are in the music. In MCS, there are three scrolling speeds: a gradual, steady scroll; 

measure-by-measure scrolling, which is jumpy to look at, but faster; and quick jumping from one 

place to another, which is the fastest of all. 

To scroll gradually, you have two options: : 7 

Move the pointer to the one of the arrows on the ends of the scroll bar and 

hold down the mouse button. | | 

6 Press the left or right cursor arrow on the keyboard, and hold it down to 

scroll. 

To scroll measure-by-measure: 
¢ Click anywhere on the scroll bar, either to the left or right of the white 

cursor. This moves you back or ahead about two measures. 
é Press the up-arrow on the keyboard to move forward one measure, or the 

down-arrow to move back one measure. 

To scroll quickly through the document: 
@ Grab the white cursor in the scroll bar with the pointer, and move it to the 

left (to go backward) or right (to go forward). 

é Type Command-H to return to the beginning of the piece (H stands for 

Home), or Command E to go to the End. : 

The Parts Box 
The Parts Box, at the bottom of the screen, offers a collection of musical symbols for you to use while 

you're building your music. | 

Eighth Notes Double Sharp 

Half Notes Sharp Tempo Slider 

teraPevere eat cNaatataterete’ OS 

Whole Measure Rest 

Half Measure Rest 

Whole Note 

Quarter Note Rest 
Eighth Note Rest Double Flat 
Sixteenth Note Rest Triplets, Quints 

_ Thirty-second Note Rest 



To select an item from the Parts Box, put the pointer on it and click once. It "sticks" to the pointer. 
Move the pointer up to the place on the staff where you want to position the item, and click again 
to drop it from the pointer onto the staff. Make sure you hold the mouse absolutely still while you 
click, or the item may not drop off. | 

If you're going to use one item several times in a row, press the Command key while you select it 
from the Parts Box. It will stick to your pointer permanently, allowing you to "stamp" the item as 
often as you want without dropping it from your pointer. When you're done, drop the item by 
pressing Delete, or by moving to an empty spot in the Parts Box and clicking once. 

If you pick up an item, but then decide you don't want to use it, you can drop it by either pressing 
Delete, or by dragging down to an empty space in the Parts Box and clicking to release the item. To 
move a symbol that's already in the score, just click on it to pick it up, move it to its new location, 
and click again to position it. 

Now, let's find out what each of the Parts Box symbols means: 

Notes and Rests — Music is made up of alternating sounds and silences. Notes and rests are used 
to show how long each sound or silence should last before the next one starts. The MCS Parts Box 
gives you a full range of notes and rests. 

Notice that there are two kinds of half, quarter, sixteenth, and thirty-second notes: one with the 
tail extending up, the other with the tail trailing down. Generally, you'll put the notes with tails 
up above the middle line of either staff, and notes with tails down below the center line of either 

staff. But you don't have to do it that way if you don't want to: the note plays the same whether 
its tail is up or down. 

Accidental marks in the Parts Box include: 

Natural: restores any sharp or flat note to its natural tone for the rest of the measure 
Flat: lowers a note (and all subsequent notes of the same pitch) one half-step for the rest of 
the measure 
Sharp: raises a note (and all subsequent notes of the same pitch) one half-step for the rest 
of the measure 
Double Flat: lowers a note (and all subsequent notes of the same pitch) two half-steps for 
the rest of the measure 
Double Sharp: raises a note (and all subsequent notes of the same pitch) two half-steps for 
the rest of the measure. 



Other musical tools and controls in the Parts Box are: 

Tie: adds two short notes together to form a single longer note. Two quarter notes tied to 
each other play like a single half note. 

Triplet: clusters three notes together so they play as two, so each note receives 2/3 of its 
usual value 

Quintuplet: clusters five notes together so they play as four, so each note receives 4/5 of its 
usual value | 

Dot: increases the time value of one note by half. For example, a dotted quarter note is held 
for an extra eighth of a beat in 4/4 time. The dot modifies everything in a vertical area: 
for example, if you have a half note with a rest above it, placing a dot by the half note 
also extends the rest. 

Octave Up: raises the entire piece one octave above what's written. Place it above the 
staff you want to raise at the point you want the effect to begin. To lower it again, use 
Octave Down. 

Octave Down: lowers the entire piece one octave below what's written. Place it above the 
staff you want to lower at the point you want the effect to begin. To cancel this, use 
Octave Up. 

Volume Sliders: grab the arrow with the pointer and move it up to increase the playing 
volume, or drag it down to decrease it. The left slider controls the treble volume, and 

the middle one controls the bass volume. 
Tempo Slider: grab the arrow with the pointer and move it up to increase the tempo, or 

drag it down to play more slowly. The left slider controls the treble staff, and the right 
one controls the bass staff. 

How fast a piece of music is played can have a dramatic effect on how listeners react to 
it. Some pieces, like Bach's 8th Invention and Bumblebee, for instance, sound best when 

played very fast. Other pieces, like the Pachelbel Canon, need to be heard slowly, so 
you can hear the texture of the musical lines weaving together. 

Now that we've found out how to use all the features on the program screen to create music, it's time 
to take a look at the more advanced functions found on the Menu Bar. 



THE MENU BAR 

As mentioned above, there are four headings on the Menu Bar: 3 , File, Edit, and Play. To use any 

of the Menu Bar commands, put the pointer on one of the headings and press the mouse button. Hold 
the button down while you drag the pointer to the menu item you want, then release the button. 

ae 
About MCS and About the Authors contain information about MCS and the people who created it. 
Click once anywhere when you're done with these windows. Coal ae 

File 
The commands under File let you open new files, save them to a disk, and retrieve them whenever 
you want. | 

New — This command clears the computer's active memory (and the program screen) of any music 
that's currently loaded, and returns you to the beginning of the staffs. Beware: though this 
command won't affect data you've already stored on a disk, it does not save the 
music that's onscreen when you give the New command. All onscreen music vanishes 
permanently when you use New. Before it does away with your work, though, you'll see a dialog 
box that enables you to back out of any potential mistakes. | 

Open (Command-O) — Use this command to open music files that are already stored on disk. 
From the Open dialog box, you can select a file, just point at it and click, then click the Open 

button. If you have a long list of files, use the scroll arrows to move up and down in the list. If the 
song you want to work with is on another disk, eject the current disk, replace it with the disk you 
want, and click Disk to see the new disk's contents. Click Cancel to close the dialog box and return 

to the program screen. | 

Save — Select this command to save your changes to an existing file. MCS automatically saves 
the current version of the music under the name of the last file you opened. | 

Save As... — This command saves your music to a new file. Use it to select a file name and and 
save a new composition, or to save a changed version of an existing piece under a new name. For 
example, let's say you've been working on music loaded from a file called "Sonata." You've made 
some changes that you like, but you also want to keep the version you originally loaded. Select 
Save As... , then, at the prompt, type in a new file name — maybe "Sonatal." MCS saves your 
new version to the new file, leaving the original "Sonata" untouched in its own file. 



Print — Use this command to format and print your compositions. Make sure your printer is 
connected, plugged in, and turned on before issuing the Print command. Refer to the command 
summary card for specific printer information. 

Edit | | 
The Cut, Copy, Paste, and Clear commands let you take a group of notes, a few measures, or even 

a several lines from one part of a song, and copy or move them into another part of the song — or to 
another song entirely. | 

To select a section of music, place the pointer where you want the selection to begin or end. Clicking 

the mouse button places an insertion line at that point in the score. Hold the button down while you 

drag the mouse: notice that the entire staff, between the insertion line and the pointer, turns pink 

as you select it. You can select music forward (right) or backward (left) from the insertion line, or 

move the pointer up or down to select both staffs at the same time. (Note that you can't use the 
insertion line to select clef signs, key signatures, or time signatures.) When you've selected all the 
music you want to work with, release the mouse button. If you change your mind, un-select by 
clicking once anywhere on the screen. (Be careful not to click on another note.) To get rid of the 
insertion line, click once in an empty part of the Parts Box. 

Now, let's see what you can do with the selected music: 

Cut (Command-X) — The Cut command removes selected measures and holds them in the 

Clipboard. You can use Cut to snip out and hold a bit of music that you'd rather use somewhere else. 

Note that, when you cut measures from your piece, all the music that follows that measure moves 

up to fill the gap. (If you're only cutting from one staff, this means that your treble and bass music 

may no longer match.) 

To cut a section you want to move, select the music you want to cut, and release the mouse button. 
Pull down the Edit menu and select Cut. The selected music disappears from your score, and the 
measures that follow it move up to take its place. Use the Paste command (explained below) to 
insert it in a new location. 

To delete a section, select the offending notes, then press the Delete key. 



Copy (Command-C) — This work just like Cut, but it only takes a copy of the selection, 
without disturbing the score. This is useful if you have a series of notes, like a bass line or a chorus, 
that recur frequently in your song. By using Copy, you only have to construct the passage once, copy 
it to the clipboard, and paste it wherever you want, as often as you want. | 

Select the music you want to copy, and release the mouse button. Pull down the Edit menu and 
select Copy . The selected music remains in place within the score. To place the copy in a new 
location, use the Paste command below. 

To copy music into another file, follow the Copy instructions above, then close the file you're 
working in. Immediately open the second file and follow the Paste instructions below. 

Paste (Command-V) — Inserts cut or copied passages into their new location. Put the pointer 
where you want the new music inserted, and click once. The pink insertion line appears. Select 
Paste from the Edit menu, and MCS automatically copies the notes from the clipboard and places 
them in your score. 

Clear — Select Clear to erase any music that's currently highlighted 

Move Up (Command-U) — This moves selected notes up to the next line or space. 

Move Down (Command-D) — Moves selected notes down to the next line or space. 

A Few Words about Editing -—-When using Cut and Paste, bear in mind that you're very 
likely taking notes out of some measures and adding extra notes to others. You may even take away 
a measure bar or two, or put two bars next to each other. Since music is based on an even number of 
beats per measure, you can see that this might pose problems when you want to play the piece. You 
have two options here. 

First, you can use the Count Beats Per Measure command (discussed below) to go through the 
piece and alert you to measures that don't have the number of beats indicated in the key signature. 
Once you know where they are, you can fix them. 

Second, you can just play the music like it is. MCS ignores the measure bars and plays each note for 
its full value, so the music sounds just fine. However, since the measure bars are the basis of the 
screen's scrolling speed, it's possible that the music you hear will be out of sync with what you see 
on the screen. 

10 



Here are some tricks you can perform with the Edit commands: 

1. Create A New Measure — Put the insertion line to the right of the first measure bar, 
and select the entire measure, ending just past the next measure bar. Then Cut. When you 
paste your selection into its new location, it will enter the score as a complete measure, 
without disrupting the number of beats in other measures. All the music following the cut 
point will move forward one measure to fill the gap. 

. Replace An Existing Measure — Want to replace the notes in one measure with notes 
from another? Go to the measure you want to copy, select all the notes between the measure 
bars (but not the bars themselves), and choose Copy or Cut from the Edit menu. Now, 

move the pointer to the measure you want to replace, and highlight all the notes (but 
again, not the measure bars). When you give the Paste command, the notes in the 
clipboard replace the selected measure. 

Merge Two Measures — This may be the cutest trick of all. You can lay the notes from 
one measure over another measure: all the notes from both measures will be played. To do 
this, go to the measure you want to copy from and select all the notes between the measure 
bars (but not the bars themselves). Choose Copy or Cut from the Edit menu. Now, move 
the pointer to the measure you want to merge into, and click to place the insertion point 
between the left measure bar and the first note. When you give the Paste command, the 
measure in the clipboard is laid over the existing measure. The notes in both measures 
retain the same spacing they had before, so you may want to move the notes around to 
create chords or clean up the spacing. 

Delete A Measure — Removing the line that separates two measures is not like linking 
boxcars. Though you might expect to get one very long measure with twice the number of 
beats, what actually happens is that the second measure snaps back to overlap the first 
one. When you play them, they play simultaneously. The best way to avoid this is not to 
delete measure bars in the first place. If it happens, copy a measure bar from somewhere 
else in the music and use it to replace the missing one. Then, manually sort out the notes 
and put them back in the measures where they belong. 

11 



Play 
We've been talking a lot about what things look like and how they work; the four commands in the 
Play menu let you hear how it all sounds. Which is, of course, what MCS is all about. 

Play — Music, maestro, please. Play starts the music at the first full measure shown on your score 
screen, and keeps going until the music ends, or until you click the mouse button to stop it. 

Treble: Instrument — A number of instruments are included on your MCS disk. You can use these 
instruments, alone or in pairs, to create different effects with your music. The Treble: command 
opens a dialog box that allows you to choose an instrument for the notes in the treble clef. The 
default instrument (the one that plays if you don't choose something else) is the piano. When you 
select an instrument, the instrument name appears after Treble: in the menu bar until you choose 
another one. 

Bass: Instrument — In addition to designating an instrument for the treble clef, you can choose a 
second instrument to play the bass clef. If you don't choose a second instrument, the selected treble 
instrument will play both staffs. 

Check Beats Per Bar — This command searches the entire score to find places where you've put 
too many or too few beats in a bar. If it finds an uneven measure, you'll see a dialog box: "Too many 
beats in measure, continue checking or cancel?" If you choose to continue, the program goes on 
without letting you fix the measure. If you click Cancel, the beat checker stops so you can adjust 
the measure. When you're through, select the Check Beats Per Bar command again. The beat 
checker returns to the beginning of the song, and starts counting. 
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CHAPTER 3: HANDS-ON MUSIC 

You're acquainted with all of Music Construction Set's features, so now it's time to see for 
yourself exactly what kind of music you and MCS can make together. The exercises below introduce 
you to accidentals and transposition; let you explore the Cut and Paste commands; and open the door 
to more complex musical ideas like bass lines, variations, and chords. 

You'll create all the the music you need for these demonstrations as we go along. Now that we've 
been introduced, shall we dance? 

KEY SIGNATURES 

As we saw in the previous chapter, the eight-tone scale has a few peculiarities that increase the 
complexity of working with music. The first peculiarity is that, even though the lines and spaces 
are evenly laid out on the staff, the sounds they represent are not. The steps aren't simply 
sequential: there are half-steps as well, and they are written with sharps, flats and naturals. 

The second peculiarity, which becomes apparent when you look at how the black keys on a piano 
are spaced, is that there are two places in the scale that go up a full step at a time, without a 
half-step in between: once between E and F, and again between B and C. Those tones are just 
naturally a half-step apart, a fact that has a profound effect on your ability to raise or lower the 
overall pitch of the music. 

Try this out by creating a scale on your screen. Select a quarter note from the Parts Box while 
holding down the Command key. Now, look at the treble clef and imagine that there's one more 
line running under it. Drop a note on that imaginary line. When you click to release the note, notice 
that a short horizontal line appears, running through the note's head. It's called a ledger line, and 
appears automatically whenever you place notes above or below the five lines of a staff. 

This first note is middle C. (If you need help finding it, hold down the Command key as you move 
the pointer around. The letter name of the line or space you're on appears in the lower right corner 
of the Parts Box.) Now, place a second note in the "space" that would occur just above the line that 
middle C sits on. That's D. The third note goes on the lowest line of treble staff — E. The space 
above it is F. Put the fourth note there. 
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Now you've got four beats in this measure. Since you're in 4/4 time, this means it's time to move on 
to the next measure. In the second measure, put four more notes on line G, space A, line B, and space 

C. Voila! A C major scale! Select the Play command from the Play menu, and listen to how it 
sounds. Next, use the pink insertion line to select the two measures of your scale. From the menu bar, 
select Move Up from the Edit menu. Play the scale again, and notice how strange it sounds. 
That's because your ear is used to hearing half-steps between the third and fourth notes, and again 
between the seventh and eighth notes. When you move the notes up a step and start your scale with 
D, these relationships change: the half-steps now occur between the second and third notes, and 
between the sixth and seventh. To restore order to these notes, insert sharps before the third and 
seventh notes (that is, F and the C), and play the scale again. The D scale is one step higher than 
the C scale you heard before, but the note relationships are now the same. 

Different songs are written in different scales, or keys. The key signature — the cluster of sharps or 
flats next to the time signature at the beginning of some pieces — tells you which scale you're using. 
Because the key signature indicates right at the start that every F and C should be played sharp, 
you don't have to put a sharp next to every F and C note in your song. Since we're about to change 
the key signature, take the two sharps out of your scale now. 

As we saw above, a staff with no sharps or flats to the left of the time signature is tuned to the key 
of C. Now, start clicking in the area to the left of the time signature. First, you get one sharp on 
line F. This is called the key of G, because, if you start your scale on G, you need that one sharp on 
every F note to create the correct whole step/half-step pattern. Click once more, and you get two 
sharps — one on F and one on C — exactly what you need for your D scale! (Play it and see.) One 
more click gives you three sharps (an A scale), and so on. 

You can put up to seven sharps or flats in your key signature — and then the cycle starts over again 
with C. If you're the type who likes to read about such things, you're in for a treat: the libraries 
are full of interesting books on music theory, and your MCS program provides a perfect "now let's see 
if | understand what that means" testing ground to use as you read. 

Just one more fact about keys and scales: they come in two flavors, major and minor, as the chart 
below shows. To see how this works, select your scale and use the Move Down command from the 
Edit menu to bring it back down to C. Now, click the key signature until you have three flats, and 
play it. The intervals are all different (the flats make sure of that) but the scale is still 
recognizable, though it has a completely different feel to it. It's a C minor scale. For your future 
experiments with major and minor keys, use the key signature chart below to find out what 
accidentals you need to create the effect you want (remember that scales are named after the note 
they start on): 
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Minor Scale Number of Sharps or Flats Sharps or Flats Used Major Scale 
No accidentals none C major A minor 
1 sharp F G major E minor 
2 sharps EC D major B minor 
3 sharps F,C,G A major F# minor 

4 sharps F,C,G, D E major C# minor 

5 sharps F,C,G, D, A B major G# minor 

6 sharps F,C,G,D,A,E F#major D# minor 

7 sharps F, C, G, D, A, E, B C#major A# minor 

1 flat B F major D minor 
2 flats B, E B flat major G minor 
3 flats B,E,A E flat major C minor 

4 flats B, E, A, D A flat major F minor 

5 flats B, E, A, D, G D flat major B flat minor 

6 flats B, E, A, D,G, C G flat major E flat minor 

7 flats B, E, A, D,G, CG, F C flat major A flat minor 

CUT AND PASTE 

Cut and Paste are two of the most versatile and powerful tools in your Music Construction Set. 
They are great timesavers, letting you take advantage of the way repeated patterns are used in 
music to reduce the amount of work involved in copying and composing. 

In this section, you'll use MCS to write a piece of music. If you think you might want to save the 
music, make sure you have an formatted music files disk ready before you go on. To format a new 
disk, refer to your computer operating system manual. 

Select New from the File menu to clear the screen of any music you were using before, and make sure 
you're in 4/4 time. Hold down the Command key and select a quarter note from the Parts Box. Move 
up to the bass staff and drop a note in space C — the second one from the bottom. Place three more 
notes in the measure, on any C,G, E, or B line or space. (If you use a B, grab a flat from the Took Kit 
and put it just before the note.) You can put all three notes on one pitch, or make them all different 
pitches. It's up to you. 
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Move the pointer to an empty space and press Delete to drop the note. Select the entire measure, 

plus the measure bar that follows the notes. Select Copy from the Edit menu. Now, place the 

insertion line at the start of the second measure, and press Command-V (the keyboard shortcut for 

Paste) eleven (11) times. Click in the right end of the scroll bar a few times to make sure you have 

twelve identical measures of bass line, then press Command-H to return to the start of your song. 

In the first measure of the treble clef, use half, eighth, and sixteenth notes to write four beats of 

music using the same C, E, G, and B flat pitches you used before. Select the second two beats of the 

measure (but not the subsequent bar line!) and copy them twice into the second measure. Make sure 

the notes you select exactly total two beats. This gives you four beats of music in the second 

measure, too. 

Select and copy the entire two measures in the treble clef. Using Command-V, paste them five 

times. The result is twelve measures of melody (treble staff) and bass line (bass staff). But before 

we play it, let's do one more alteration. 

Select both the top and bottom staffs of the second measure. From the Edit menu, select the Move 

Up command three times. This raises the notes three steps. Select measures five and six, and raise 

them three steps as well. Raise measure nine four steps, and measure ten three steps. Grab the 

white rectangle in scroll bar and drag it all the way to the left to return to the start of the piece. 

Now you're ready to Play your own original 12-bar blues! | 

Great stuff, right? But you're only getting started: there's plenty you can do to tweak your 

composition around. 

Chords 
As you've seen, MCS lets you build music in which several notes sound at the same time (check your 

reference card to see how many your computer can handle). These vertical stacks of notes that play 

simultaneously are called chords. You can construct chords of notes with different values — that 

is, mix half notes and quarter notes, and so forth. (The only exception is dotted notes, which make 

all the notes in the chord play the same duration. It's best if you don't put a dot near a chord unless 

all the notes in the chord have the same value.) 
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A good starting point for chord building is by "adding thirds". If a note is on a line, the interval 

between it and the note on the next line above it is called a third. Similarly, the interval from one 

space to the next is a third. If you simply go through a song and put in extra notes a third above the 

existing ones, you'll usually like what you hear. And you can go through again adding occasional 

thirds above the ones you already put in, taking away some of the others, and just generally 

messing around until you hear the effect you want. 

Try this with your blues piece. Start by adding thirds to the first and third notes of your bass line, 

and see how it sounds. 

To develop a more sophisticated sense of how chords work in music, you might find guitar songbooks 

especially helpful. Such books usually contain the melodies of songs, along with the names of the 

chords the guitarist should play as accompaniment. Your MCS, plus one of those books and a chord 

chart designed to show what notes go in each chord (some books have such charts right in them), 

can give you a lot of practical insight into how chords and melodies fit together in songs. And if 

you'd like a more formal understanding, look in your library for an introduction to music theory, and 

use MCS to build examples you can listen to as you read. 

Variations 
Taking a basic melody and altering it as you play is one of the oldest forms of musical invention. 

When jazz musicians play solos, they are usually playing variations on the melody of whatever 

song they started with (called the "head"), or on a chord progression implied by the head melody. 

Many classical pieces are built on the concept of variations: listen to recordings of Beethoven's 

Diabelli Variations, or Brahms’ Variations on a Theme by Haydn, for instance. To begin with, 

experiment with variations on your 12-bar blues; or experiment with the CANON included on your 

MCS disk. You can stay close to the original melody or wander far away from it; but you should 

remain faithful to the harmonies of the original melody, which are often expressed by the chords 

in the bass clef. 

There are a number of different styles of music on your MCS disk: canon and scherzo, waltz and 
ragtime, and so on. There are books written about all of these musical forms and more, and you 

should seek them out if you want to read in depth about any given style. But the first requirement is 

to listen. As you enter pieces into the the MCS, exploring the styles and composers you like best, you 

will become closely acquainted, note by note, with the personality of each piece. Then step back 

and listen to what you've entered, paying special attention to the family resemblance of your 

ragtime or canon to other pieces like it. Making yourself a part of those families is the secret to 

writing good music. 
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A MUSICAL GLOSSARY 

Accidental — a generic term for sharps, flat, and naturals 

Bass clef — a symbol that occurs at the beginning of a musical staff to indicate that the notes on 
the staff are below middle C. It looks sort of like a backwards C. 

Bass line — a series of low notes that rhythmically repeat throughout a song , with little 
variation 

Chord — a vertical stack of several notes with the same time value, to be played simultaneously 
as one note 

Clef — a symbol at the beginning of a staff that indicates whether the notes on the staff fall 
above or below middle C 

Common time — 4/4 time. The most commonly-found time signature in music. 

Cut time — 2/2 time. It's used in very fast 4/4 pieces —too fast to be counted at four beats per 
measure. 

Flat — When placed in front of a note, a flat sign lowers the note one half-step 

Half time — 2/4 time 

Key signature — a cluster of flats or sharps at the beginning of a piece that indicate what key 
the piece is played in. 

Measure — a series of vertical bars passing through both staffs. There are a consistent number of 
beats (usually four) in each measure. 

Middle C — a note that lies directly in the middle of a piano keyboard. Notes above middle C 

are written in the treble clef; notes below are written in the bass clef. , 

Natural — an accidental that reverses a sharp or flat, restoring the note to its regular pitch 
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Octave — Between notes with the same letter name (for example, one G and the next higher G), 

there are eight notes. The distance between the two Gs is an octave. 

Sharp — When you attach one to a note, a sharp sign raises the note one half-step. 

Staff — the row of five parallel lines on which music is written. 

Time Signature — a symbol at the beginning of a piece that indicates the number of beats per 
measure, and the value that each note receives. It looks like a mathematical fraction. 

Transposition — Raising or lowering all the notes in a piece to another key, while maintaining 
the same relationships between the notes : 

Treble clef — a symbol that occurs at the beginning of a musical staff to indicate that the notes on 
the staff are above middle C. It looks sort of like a backwards S. 

Variation — Altering a given melody by changing chords, tempo, harmonies, key, and other 
musical options. 
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